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[bookmark: _Toc106360502]Welcome
Welcome to the CTR Research Report Template. This template provides a simple structure for writing and formatting research reports, using Microsoft Word styles. You will find contact information for help with this template at the end of this chapter. Chapter 2 illustrates styles used in the report template. You’ll notice that our body text is set to provide spacing between paragraphs (so you don’t need to use a hard return between paragraphs).
Note that the chapter number and title are on the same line. This makes our job a little easier when we are inserting metadata and bookmarks into the PDFs prior to your report’s online publication. Metadata makes it easier for people to find your work online (search engines pull from PDF metadata) and bookmarks make it easier for people to find what they are looking for within your work.
[bookmark: _Toc106360503]How to Use Styles
Microsoft Word “styles” are different types of formatting (font type and size, line spacing, justification, etc.) saved and named so that you may easily apply the same type of formatting throughout a document. The following sections describe how to access and use styles in Word 2010 and beyond. 
1.1.1. [bookmark: _Toc106360504]Finding the Styles
To apply styles to your text, go to the Styles group on the Home tab. You can quickly apply a style from the gallery of styles—just select the text you’d like to apply a style to, and click on the style name. To see a complete list of the available styles in your document, click the Styles Dialog Box Launcher by hitting the little arrow in the bottom right corner of the Styles group (circled in red in Figure 1.1).
[image: ]
[bookmark: _Ref498090574][bookmark: _Toc104970987]Figure 1.1 The Styles group on the Home tab

Importing Styles to a Document 
If you’ve already started writing your deliverable in another document, you can add the styles from this template into it. Click the arrow in the bottom-right corner of the Styles box on the Home tab. In the Styles pop-up, select the middle, Manage Styles, button. Then click “Import/Export” in the bottom-left corner. Under the right column click “Close file,” and then “Open file.” Search for this file (you will need to change the type of file to “All File Types” in the bottom-right), open it, and then select all styles you want to transfer to your current document. Select “Copy.” These styles should now be available for you to use.
[bookmark: _Toc106360505]How to Automate Caption Numbering and Cross-References
[bookmark: _Toc106360506]Using the “Insert Caption” Function
To get the auto-numbering on the figure caption, by the way, select the graphic and go to the References tab, where you’ll hit “Insert Caption” (as Figure 1.2 shows). In the “Caption:” box will appear the item type and number (such as Figure 1.1); you just go ahead and type in your caption in that box and hit OK. Once the caption appears below your figure, please style it with “ctr figure caption.”
[image: ]
[bookmark: _Ref498090660][bookmark: _Toc104970988]Figure 1.2 The caption creation dialog box
[bookmark: _Toc106360507]Using the “Cross-Reference” Function
If you’d like, you can insert an auto-updating figure or table number in your text. This is handy if you are adding/removing tables and want your in-text references to match up with your new table and figure numbers (without having to manually update them). Just position your cursor where you want the figure number to go, then go back to the References tab and hit “Cross-reference” to arrive at the dialog box shown in Figure 1.3. Make your selections from the reference type box and set the “Insert reference to:” field to “Only label and number.” Hit OK and you’ll see the cross-reference content pop up in your text.
[image: ]
[bookmark: _Ref498091124][bookmark: _Toc104970989]Figure 1.3 The cross-reference dialog box
[bookmark: _Toc106360508]Applying Automation to Table Titles Too
All the tips about creating automated captions and cross-references for figures go for tables titles and cross-references as well. Note that Table 1.1 is just a sample—you don’t have the make your tables match that style or appearance. Remember: once the title appears above your table, please style it with “ctr table title.”
[bookmark: _Ref499640034][bookmark: _Toc104970983]Table 1.1 Here's a sample table.
	Variable
	Coeff.
	t-stat

	Constant
	-6.116
	-0.83

	GDPt,t-1
	1.151
	2.14

	Dlinesq,t-Dlinesq,t-1
	-0.670
	-2.32

	RPSt
	10.623
	2.27


Updating the Auto-Numbering
Here’s a quick way to make your in-text references updates themselves if you have moved or deleted your figures and tables: you can hit Ctrl A + F9. This updates all the updateable fields in your document. You’ll notice that if you go to print without having updated your fields (Ctrl + P), Word will automatically update them. In fact, Ctrl + P is a smoother update—but you don’t have to actually print! You can just back out of that screen using that arrow in the top left corner, circled in Figure 1.4.
[image: ]
[bookmark: _Ref499638514][bookmark: _Toc104970990]Figure 1.4 The print dialog box—escape hatch in the top left corner
Addressing Potential Auto-Linking Error Messages
Figure 1.5 is just an example figure. Here’s a fun experiment: delete Figure 1.5 and its caption, then update your fields and see what happens to the cross-reference that begins this paragraph.
[image: ]
Source: image source
[bookmark: _Ref497996267][bookmark: _Toc104970991]Figure 1.5 Example figure caption
[bookmark: _Toc106360509]Styles Used in This Template
Listed below are the template styles in the order they appear in this document. The next chapter provides examples of all these styles in use. 
ctr DOT fields (used in the DOT form)
ctr front matter title (used for the titles of front matter sections such as Disclaimers and Acknowledgements)
Heading 1 (use this for your chapter titles to take advantage of the auto-numbering of Headings 2 through 6)
Heading 2
Heading 3
Heading 4
Heading 5
ctr body text
ctr figure caption
ctr table title
ctr bulleted list
ctr bulleted sublist
ctr blockquote
ctr back matter title
ctr references listing
ctr appendix subhead
ctr figure caption (appendix)
ctr table title (appendix)
[bookmark: _Toc106360510]Margins and Such
We’ve set the margins at 1 inch on top and bottom and 1.5 on both right and left sides. One-inch margins all around are also acceptable.
Also, you’ll notice that our body text has no initial indent and no hard returns between paragraphs. All the main body text is styled as “ctr body text.”
[bookmark: _Toc106360511]Need Help?
Contact Sarah McGavick, CTR Editor:
smcgavick@utexas.edu or 512.232.3128.


[bookmark: _Toc106360512][bookmark: _Toc481679763]Accessibility
[bookmark: _Toc106360513]It’s Required!
Compliance with accessibility guidelines is now required for all state and federal research deliverables that will be made public. This ensures that readers with physical or visual impairments can read your publications. The library has an international customer base—researchers worldwide need to access your research. The benefits extend beyond our library: an ADA-compliant document (often referred to as Section 508–compliant or compliant with other specific guidelines like WCAG) is more easily findable to search engines and thus increases your readership.
[bookmark: _Toc106360514]RTI University Handbook, 2022
From Chapter 6 Section 1:
Each university shall provide electronic deliverables that meet federal requirements for digital accessibility (WCAG 2.0 Level AA), particularly alternative text for images, to allow for easy conversion for online, public publication and access meeting legal requirements. If the University does not have the resources to publish an approved deliverable in accordance with RTI’s instructions, the University may contact RTI to discuss potential options. TxDOT may opt to publish the deliverable, using TxDOT or other resources.
[bookmark: _Toc106360515]CTR Accessibility Resources
The former CTR Library Manager put together a page on accessibility in the CTR Wiki page: https://wikis.utexas.edu/display/ctrsupport/Accessibility+of+Documents. It contains brief explanation of many accessibility issues, alongside links to more in-depth information.
In addition, she put together an hour-long PowerPoint presentation full of examples of how to follow accessibility guidance: https://library.ctr.utexas.edu/Presto/home/home.aspx?ssid=Section_508. 
[bookmark: _Toc106360516]Figures
[bookmark: _Toc106360517][bookmark: _Ref125626143]Alt Text
All figures must have alt text. Alt text is typically 1–2 sentences and should express whatever the image was meant to convey. However, if something is purely decorative, you can mark it as such. 
Keep in mind when writing alt text that the caption will be read first, and the alt text should not be redundant to the caption. You can also point to other sections in the alt text if they interpret or explain the image.
For more information, here is a guide to alt text created by UTRGV: https://www.utrgv.edu/eolc/_files/2017/posters/handouts/a-guide-to-alternative-text.pdf. 
There are two ways to add alt text in Word on a PC.
Adding Alt Text One Image at a Time[bookmark: _Toc104970992]Figure 2.1. Inserting alt text

To add alt text to each image individually, right-click on the image and scroll down to “Edit alt text,” fourth from the bottom. An alt text box will show up on the right column.
[image: ] 

Adding Alt Text to All Images Consecutively
If you’re adding alt text to all images at once, an easier way to do this is to select the “Check Accessibility” button on the left under the top Review tab. Then a box should open up in the right column with a list of all images missing alt text. You should be able to click on each one and add alt text.
[bookmark: _Toc106360518]Color
Colorblindness is fairly common among sighted readers. To ensure that people who see colors differently will still be able to interpret your figures, ensure that you are never using color as the only way to convey information. For instance, in a charft, instead of using just color to distinguish lines or bars on a graph, also use patterns or different kinds of lines.
[bookmark: _Toc106360519]Tables
To ensure that tables can be read by screen readers, ensure that header cells have been marked as such. If you have a very complicated table with a variety of merged and split cells, or two different tables mashed together, consider breaking them up into separate tables or finding another way to design the table.
[bookmark: _Toc106360520]Repeat Header Rows
For any table that may split over a page break, it’s helpful to ensure that the header rows will carry over so that readers don’t have to scroll back up to make sense of the table. To do this automatically, select the “Repeat Header Rows” button on the right under the Layout tab. Do not split a table up yourself.
[bookmark: _Toc106360521]Ensuring Readable Tables
While it can seem simpler to just create a screenshot of a table and insert it into the deliverable, rather than copying in the original table from Excel, an image of a table of course will not be readable by a screen reader. If the table is simply meant as an example, such as a screenshot of an interface, this is fine—just be sure to add alt text to the figure. 
However, if the intention is for readers to read the table content, you must copy in the original table or build it in Word.
[bookmark: _Toc106360522]Color
As for figures, ensure that color isn’t the only way information is being conveyed. For instance, the following table would be unintelligible to someone who couldn’t see the colors, but by adding words, it will be readable to a colorblind person and a screen reader.
[bookmark: _Toc104970984]Table 2.1 Inaccessible table
	
	Method A
	Method B
	Method C

	Morning
	
	
	

	Afternoon
	
	
	


Red = unacceptable
Yellow = acceptable
[bookmark: _Toc104970985]Table 2.2. Accessible table
	
	Method A
	Method B
	Method C

	Morning
	Acceptable
	Unacceptable
	Acceptable

	Afternoon
	Unacceptable
	Unacceptable
	Acceptable



Equations
Complex equations typically also require alternative text to be understandable to a screen reader, both conceptually and structurally, if they include math characters. However, as alt text can only be added to figures, this does require an extra step. 
[bookmark: _GoBack]One option is to take a screenshot of the equation and then replace the equation text with the screenshot. Alt text can then be added as explained in 2.3.1. Alternately, there are some programs that can do this automatically (e.g., ExtendOffice.com), but we can’t vouch for their safety from malware or tracking.
Equation alt text example from the University of Central Florida:
This is the original equation as an image:[image: gravity] Alt text options:
· The force of gravity is proportional to the product of the two masses and inversely proportional to the square of the distance between them.
· F equals G times m sub 1 times m sub 2 over r squared, where F is the force between the masses, G is the gravitational constant, m1 is the first mass, m2 is the second mass, and r is the distance between the masses.
· F equals G times m sub 1 times m sub 2 over r squared.

[bookmark: _Toc106360523]Get Your Work Read
An essential component of research is publication. Publication won’t get you far without distribution, however. Make sure your work is accessible by including your ORCID ID and meeting ADA guidelines for accessibility. 
[bookmark: _Toc106360524]Know and Use Your ORCID ID
ORCID is a nonprofit organization helping create a world in which all who participate in research, scholarship, and innovation are uniquely identified and connected to their contributions and affiliations, across disciplines, borders, and time. As of January 1, 2016, ORCIDs are required for researchers who must comply with the U.S. DOT Public Access Plan—this means you. 
ORCID provides a persistent digital identifier that distinguishes you from every other researcher and, through integration in key research workflows such as manuscript and grant submission, supports automated linkages between you and your professional activities ensuring that your work is recognized.
On the DOT form (that very first page), provide the ORCID URL after each author name, when available. 
Example: Josiah Carberry, Ph.D. http://orcid.org/0000-0002-1825-0097


[bookmark: _Toc106360525]Heading 1
The style used for paragraph blocks is ctr body text. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris
[bookmark: _Toc106360526]Heading 2
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris.
[bookmark: _Toc106360527]Heading 3
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris. See Figure 4.1
[image: ]
[bookmark: _Ref498004894][bookmark: _Toc104970994]Figure 4.1 ctr figure caption, source: xyz
Heading 4
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation.
Heading 5
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. 
This style is ctr bulleted list
ad 
minim 
This style is ctr bulleted sublist 
quis nostrud 
exercitation 
ullamco
[bookmark: _Toc106360528]Heading 2
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. See Table 4.1.
[bookmark: _Ref497996423][bookmark: _Ref498004650][bookmark: _Toc104970986]Table 4.1 ctr table title
	Class
	WPD
	Wind Speed (meter/second)

	1
	0–200
	0.0 – 5.6

	2
	200–300
	5.6 – 6.4

	3
	300–400
	6.4 – 7.0

	4
	400–500
	7.0 – 7.5



quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor 
This style is ctr blockquote. It has the required characteristics of a blockquote: indented on both sides and a smaller font. Lorem in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est laborum. 
quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor 
[bookmark: _Toc106360529]Back Matter Styles
Finally, we have the back matter styles, which govern the appendices and references. These sections do not follow the numbering of the main body of the report, so they use a different style while giving a uniform appearance.



[bookmark: _Toc106360530]References
This style is ctr references listing. (2008) Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. 
American Wind Energy Association (2014) Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
Apergis, N., and Payne, J. E. (2010) Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

	Reminder: the authors are responsible for ensuring references are properly formatted and cited, with a consistently applied format for both the references listings and the in-text cites. 
If you need help correctly formatting your references, check out NoodleTools—a web-based student research service that helps you correctly cite sources in MLA, APA, and Chicago/Turabian citation styles. Use NoodleTools throughout a research project to track your sources, take notes, create outlines, collaborate with classmates, and format your references list. 
Available through the UT Library System: https://guides.lib.utexas.edu/citesources/noodletools  
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[bookmark: _Toc481679764][bookmark: _Toc106360531]Appendix A. Landscape Example
This section is set up for landscape orientation.
[image: ]
[bookmark: _Toc499640642]Figure A.1 Here’s another sample figure.


[bookmark: _Toc481679765][bookmark: _Toc106360532]Appendix B. Portrait Example
This appendix returns to the portrait orientation. 
Appendix Subhead
The following table is manually numbered. I’m working on a way to create auto-numbered styles based on appendix numbering—Word is resistant so far to having two independently automated systems in one file. Stay tuned!
[bookmark: _Toc55995788]Table B1. Another sample table
	Variable
	Coeff.
	t-stat

	Constant
	-6.116
	-0.83

	GDPt,t-1
	1.151
	2.14

	Dlinesq,t-Dlinesq,t-1
	-0.670
	-2.32

	Adjusted R square
	0.250
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